
chapter 
fourPreparing to Edit

Just as a darkroom must be prepared before it can be used, you’ll need to make a few 
preparations to Capture NX before you can start editing in earnest. Fortunately, working 
with Capture NX doesn’t require any hazardous chemicals, and you don’t have to worry 
about darkening your windows. You will, however, need to make some preference adjust-
ments to help Capture NX better represent the colors in your image.

Getting predictable color from any image editing program is not easy, but Capture NX 
offers some simple color management tools that make color reproduction more predict-
able. In this chapter, we’ll take a look at some of the basics of color management theory and 
how color management is handled in Capture NX, so you’ll have more consistent color 
throughout your workfl ow.

CONFIGURING CAPTURE NX FOR
COLOR MANAGEMENT

If you’ve ever printed any of your images, you already know that your printed out-
put very rarely, if ever, matches the images that you see on your monitor. You might 
also have noticed that as you move an image from one computer to another and look at 
it on different displays, its color varies tremendously. To help make the color in your 
images more consistent from device to device and from your camera to your printer, 
Capture NX provides industry standard color management features. If you properly con-
fi gure these features, you’ll fi nd that the color in your images is much more consistent 
from device to device.
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Even if you never plan on printing, it’s worth taking advantage of color management 
technology. As your computer monitor ages, its colors will shift, and it will likely become 
dimmer and less contrasty. Diligent use of color management technology can keep your 
images looking consistent as your monitor ages. 

Color management can be a very “dense” topic if you choose to get into a lot of the under-
lying theory. Fortunately, for everyday use, you can get by with a few simple controls and a 
handful of guidelines. Keeping your system color accurate will take very little time.

Color Management Basics
A lot of factors make color consistency a diffi cult goal. For one, there’s the simple fact that 
color is subjective; everyone sees color slightly differently. But there are also some hard 
and fast objective diffi culties.

As you may have learned in grade school fi nger painting class, by mixing a few primary 
colors together, you can create other colors. Similarly, if you’ve ever set up an inkjet 
printer, you know that you put just a few ink cartridges in—usually cyan, magenta, yellow, 
and black—and yet your printer is able to spit out full-color images.

Your digital camera and your computer monitor work the same way. They combine the 
three primary colors of light—red, green, and blue—to create all of the other colors that 
they need (Figure 4.1). However, there’s an important difference in the way your camera 
combines colors and the way that a printer combines colors.
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Figure 4.1 Your digital camera creates 
colors by combining the three primary 
colors of light: red, green, and blue. 
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Color systems

Your printer creates color by mixing different colored inks. The primary colors of ink—
cyan, magenta, and yellow (CMY)—combine in a subtractive manner, meaning they get 
darker as you mix them together until they ultimately become a dark muddy brown. In 
theory, they should eventually turn black, but making perfectly pure inks is impossible, 
so very, very, dark brown is usually the best we can achieve. This is why black (the K in 
CMYK) is usually added to the printing process alongside the ink primary colors.

Like your eye, your camera’s image sensor is sensitive to the primary colors of light—red, 
green, and blue—which combine in an additive manner. As you mix red, green, and blue, 
the result is a lighter color. Mix equal amounts of the three components and you get vary-
ing shades of gray or white, given suffi cient intensity of the three.

As you might imagine, trying to translate one set of primary colors that mix together in 
an additive process into a different set of primary colors that mix together in a subtractive 
manner is a very complex process. Complicating it further is the fact that these two distinct 
methods of producing color have different gamuts. You can reproduce far more colors with 
an RGB mix of colors than you can with a CMYK mix of colors. So, the broad range of 
RGB colors that your camera can capture must somehow be squeezed down to fi t into the 
more limited range of colors that can be represented with CMYK color.

As if this situation wasn’t confusing enough, different types of paper yield dissimilar 
results, and various monitors display images very differently.

Profi les

A color management system (which consists of software and sometimes hardware) works 
in the background to adjust your colors as they pass from device to device to compensate 
for the changes in the color qualities of each device. The practical upshot is that you should 
see less shift as your images pass from device to device throughout your workfl ow.

Color management software works by examining special profi les that you specify for your 
monitor and your printer. A profi le contains a description of certain color characteristics 
of each device. Your color management software uses this description to skew the colors 
as they pass through your workfl ow, so that your colors and tones appear more similar on 
each device.

Monitor profi les contain additional information, which allows your color management 
system to adjust special settings in your computer’s video card, so that your display looks 
closer to an accepted standard. This process of calibration helps different monitors deliver 
a similar image.
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Fortunately, there is a widely accepted standard for this profi ling information. The 
International Color Consortium (ICC) has defi ned a specifi cation for color profi les. Both 
the Mac and Windows operating systems provide OS-level support for these ICC profi les. 
Developing a working color management system begins with the process of building or 
acquiring good profi les for your system.

Not a magic bullet

Before we go on to profi ling, it’s important to understand one important fact: The images 
that your printer outputs will never look exactly like what you see on your monitor!

Your monitor is a self-illuminated transmissive color device with a huge gamut of colors 
at its disposal. A printed page is a refl ected color device with a narrow gamut of colors and 
a very different contrast range. As such, your colors and tones are always going to look dif-
ferent from the monitor to the printed page. So, if you’re expecting that you’ll be able to 
confi gure your color management system and from then on know exactly what will come 
out of your printer, you’re going to be disappointed.

However, a well-implemented color management system can greatly reduce the number of 
experiments and test prints that you need to make. I usually fi nd that, on diffi cult images, 
working with a color managed system decreases the number of test prints I need from 6 or 
7 to just 2 or 3. This is better than I was ever able to do in a chemical darkroom!

Profi ling Your Monitor
Confi guring your color management system begins with the creation of a monitor profi le. 
The underlying color management software uses the monitor profi le to adjust the colors 
in your image as they pass to your screen, as explained earlier. 

You can create a monitor profi le in two ways: using a software calibrator or using a hard-
ware calibrator. The Mac OS has a built-in software calibrator and Photoshop ships with 
one for Windows. Both solutions work fi ne, but you can now buy a hardware calibrator for 
under $200, and a hardware calibrator does a much better job than a software calibrator. 
So much so, that the amount of money you’ll save in paper and ink will probably pay for 
the calibrator fairly quickly. 

For getting started with color management, using a software-generated profi le will at least 
let you see how the system works.



CONFIGURING CAPTURE NX FOR COLOR MANAGEMENT 65

Software profi ling on the Mac

Mac OS X includes a built-in software monitor profi ler that builds a monitor profi le based 
on your answers to some simple questions.

To use the Apple Display Calibrator Assistant:

1. Open System Preferences and click Displays. A dialog box appears with a generic 
monitor name such as “Color LCD.” If you have multiple monitors attached to your 
Mac, a separate dialog box appears for each monitor. For now, pick a monitor that 
you want to display and move the appropriate dialog box to that screen.

2. Click the Color tab to bring up the color controls for your monitor (Figure 4.2).

Figure 4.2 Mac OS X has a built-in 
software monitor calibration system 
that you can activate from the Displays 
section of the System Preferences.

3. Click the Calibrate button to launch the Display Calibrator Assistant.

4. In the Display Calibrator Assistant, click the Expert Mode check box (Figure 4.3).

Figure 4.3 The Display Calibrator 
Assistant walks you through building 
a monitor profi le for your display.
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5. Press the Continue button and work your way through each of the screens that the 
Calibrator Assistant displays. Follow the instructions and answer each question. On 
some screens, the Calibrator Assistant will ask you to choose among several different 
patterns. You’ll fi nd this process much easier if you squint to defocus your eyes.

6. When you’re fi nished, the Calibrator Assistant will ask you to name your new pro-
fi le. You can name it whatever you want, but it’s usually best to include a date in the 
profi le name. As I’ll discuss later, keeping up-to-date profi les is very important.

Software profi ling on Windows

If you have Adobe Photoshop version 7 or later, or Photoshop Elements installed, you 
can use the Adobe Gamma control panel that installs with the software to create a monitor 
profi le.

1. Choose Start > Settings > Control Panel.

2. Double-click Adobe Gamma.

3. Select Step By Step (Wizard) and click Next (Figure 4.4).

Figure 4.4 The Adobe Gamma 
control panel lets you create 
ICC profi les for your Windows 
computer.

4. Follow the instructions onscreen to create and save a profi le.

Under Windows XP, profi les are stored in the Color directory (Windows\System32\Spool\
Drivers\Color directory).
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Hardware profi ling

For more accurate profi les—and therefore, a more effective color management system—
you’ll want to use a hardware profi ler. A hardware profi ler is actually a combination of 
a colorimeter, a small device that you place in front of your monitor, and a piece of 
included software that uses the colorimeter to analyze your monitor to create a profi le 
(Figure 4.5).

Figure 4.5 A hardware monitor calibrator 
generates a far more accurate profi le than you can 
make by eye using a software calibration scheme.

Because a hardware profi le can perform a more accurate analysis of your monitor’s char-
acteristics, hardware-generated profi les are usually much more effective than profi les that 
you create by eye using a software profi ler.

Many different hardware profi lers are available at a range of prices. The Pantone Huey sells 
for $80, whereas the ColorVision Spyder product line ranges from $79 to $280 depend-
ing on the options you select. At the higher end, products by X Rite and Gretag Macbeth 
deliver high-end quality at higher prices. All of these devices will give you better results 
than what you’ll get with a software calibrator, but you defi nitely get better profi les if you 
buy a more expensive calibrator. 

Using a hardware profi ler is very simple. After installing the included software, you simply 
follow the onscreen instructions. At some point, you’ll be prompted to mount the device 
on, or in front of, your display (Figure 4.6).

Figure 4.6 A monitor calibrator hangs 
in front of your monitor. Special software 
drives the calibrator and builds a profi le 
for you.
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Unlike with software calibration, you won’t be asked to evaluate any test patterns or image 
swatches—that’s the colorimeter’s job. Profi ling times will vary from device to device, but 
you can usually expect to have a profi le within 10 minutes.

Although it may be frustrating to have to spend even more money, you may fi nd that the 
improved accuracy of a hardware-profi led display will pay for itself fairly quickly, since 
you’ll most likely be using less printer media on test prints.

How Often Should I Profi le My Monitor?

The good news is that a monitor profi le can greatly improve the quality of your displayed image, but 
the bad news is that it won’t last. Whether you use a CRT or LCD monitor, the image on your display 
will shift in hue and brightness over time. The older the monitor, the faster the shift. If you’re working 
with a fairly new display, you probably only need to profi le your monitor once every month or so. After 
about 18 months, though, you’ll want to step up your rate of profi ling. If your monitor is a couple of 
years old, you should build a new profi le once a week.

The software that ships with most hardware profi lers automatically reminds you every week that it’s 
time to build a new profi le. You don’t need to keep the old profi les, so don’t worry, you won’t soon be 
drowning in profi les.

Also, don’t think that you can just wait until you notice a difference. Your eye can adapt very well to 
your monitor’s subtle shifts, and you may not notice how much your image has washed out, lost satu-
ration, and shifted colors. Trust your color management system and profi le regularly.

 Profi les and viewing conditions

The ambient light in the room where you view your monitor has a huge impact on your 
perception of the colors onscreen. Ideally, you want to work in a room where you have full 
control over the lighting—that is, a room with no windows and no mixed light sources. 

When you build a monitor profi le, your profi ling software will ask you the temperature 
of the ambient light in the room. You’ll usually want to pick an option that matches the 
dominant light source in your room. If you work in a windowed offi ce, this will probably 
be sunlight.

In a windowed offi ce, the ambient lighting will change throughout the day. So, you might 
have heavy sunlight for part of the day and mixed lighting or no sunlight at other times 
of the day. If you’re serious about color management, you should build separate profi les 
for each of these ambient lighting situations and change from profi le to profi le as the 
day progresses.

Some CRTs allow you to create different confi gurations of monitor settings. This allows 
you to store different brightness and contrast settings for different ambient lighting 
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situations. You can build separate profi les for each of these monitor settings, and then 
change the monitor setting and your profi le as the day progresses.

Where Is This Color Management Software?

Throughout this section I’ve been talking about the color management software that utilizes your 
profi les to correct the color on your screen and printer. This software is part of your operating system 
and runs in the background. You will never interact with it directly, other than to install profi les in the 
appropriate places. However, you will alter settings in Capture NX, which in turn will handle all neces-
sary communication with the color management software.

 Printer Profi ling
Just as your color management software needs good monitor profi les to be effective, it 
also needs quality printer profi les to accurately adjust your images for output. However, 
although you only need one monitor profi le (unless you’re creating multiple profi les 
for different ambient lighting situations), you typically need many different printer pro-
fi les installed, at least one for each type of paper and ink combination that you intend to 
print on.

Printer profi les are built using special hardware that measures printer output on a specifi c 
type of media, using specifi c printer settings. To be used effectively, you use that profi le 
with that same type of paper and same combination of printer settings. If you don’t have 
a profi le for a specifi c type of paper, you’ll have a more diffi cult time running a color cali-
brated workfl ow.

Fortunately, these days most decent photo printers ship with a collection of profi les for all 
of the paper types that the printer vendor sells for that printer. These profi les are usually 
installed when you install the printer driver. In some cases, only a basic set of profi les is 
installed with more available from the printer vendor’s Web site.

Nowadays, many independent paper companies such as Hahnemuhle provide free profi les 
for using their papers on specifi c printers. 

Unfortunately, profi le quality can vary from vendor to vendor and printer to printer. Some 
printer makers provide excellent profi les for all of their printers; some provide very good 
profi les for their high-end printers and marginal profi les for their lower-end models; and 
others don’t provide profi les at all.

Further complicating the printer profi ling situation is the fact that not every printer that 
rolls off the same assembly line is identical. As such, a “stock” profi le may be more effective 
on one unit than another depending on how well each unit conforms to the ideal baseline.
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If you aren’t getting good results from the profi les included with your printer, or if you 
want to print on paper for which you don’t have a profi le (maybe you want to use hand-
made paper, paper from an art supply store, or paper from a different printer vendor), you 
might want to consider getting a custom profi le.

Several online services will make a custom profi le for you for anywhere from $15–$40. To 
use these services, you download a few simple test pages, print them out, and mail them 
to the service. The service then returns an ICC profi le that you can install.

For the ultimate control, you can invest in your own paper profi ling hardware: but be 
warned, this gear isn’t cheap. Starting at around $1000, products like the XRite Pulse 
ColorElite provide everything you need to create custom paper profi les. The process is 
very simple, and you can usually create a profi le in about fi ve minutes, depending on the 
speed of your printer.

Installing printer profi les on the Mac

Under Mac OS X, printer profi les are stored in the Profi les folder (Library > ColorSync > 
Profi les). They can be loose in the folder or kept in a subfolder, allowing you to keep 
profi les for specifi c printers grouped together. Simply copy your printer profi les into this 
folder and restart Capture NX.

Installing printer profi les on Windows

Under Windows XP, printer profi les are stored in the Color folder (Windows\System32\
Spool\Drivers\Color folder). Simply copy your printer profi les into this folder and restart 
Capture NX.

Why Don’t I Need to Profi le My Camera?

Since I’m making such a big deal out of having accurate profi les for your monitor and printer, you 
might wonder why you don’t also use a profi le for your camera. As you’ve already seen with printer 
and monitor profi les, color profi les are very specifi c to particular situations. For example, a monitor pro-
fi le is specifi c to a particular ambient light level, whereas a printer profi le is specifi c to a particular kind 
of paper. Because your lighting situation constantly changes when you shoot, there’s no way to create 
a usable camera profi le.

However, if you’re a studio photographer who works only in very controlled lighting situations, it 
is possible to profi le your camera. Camera profi ling involves a complex process involving shooting 
expensive test charts and is way beyond the scope of this book. Lack of camera profi les, though, won’t 
prevent you from running a color managed system.
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 Color Spaces
In Chapter 2, “Basic Theory,” you learned about color spaces—mathematical specifi cations 
that defi ne the boundaries of the color range in an image. The color space that you choose 
is simply stored as a tag in the image metadata. When displaying your image, your image 
editor looks at this tag to fi nd out which color space you want to use for the image, and 
then maps the color values in the image accordingly. 

Many color space specifi cations are available, but the two most popular are sRGB and 
Adobe RGB. Of the two, sRGB is smaller; the range of colors that it specifi es is not as large 
as Adobe RGB. Probably the most noticeable difference is in the reds. An image mapped 
into sRGB has more muted reds than an image mapped into Adobe RGB (Figure 4.7).

Figure 4.7 The upper image has been 
mapped into sRGB, whereas the lower 
image has been mapped into the larger 
Adobe RGB, resulting in some colors 
being slightly more saturated.

Many digital cameras offer a menu option that lets you select sRGB or Adobe RGB 
(Figure 4.8). sRGB was designed with the hope that it would become the standard color 
space used on the Web. As you’ve probably already discovered if you’ve posted any images 
on the Web, Web pages don’t look the same from one monitor to the next. However, 
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because of its smaller color space, if you tag your images as sRGB, there’s a better chance 
that they’ll look good on a greater number of monitors. The smaller color palette of 
sRGB means you’ll stand less chance of pushing older or less advanced monitors beyond 
their capabilities.

Figure 4.8 Your camera probably 
includes a menu option for selecting a 
color space, usually sRGB or Adobe RGB.

Most quality desktop photo printers have a gamut that’s larger than sRGB. So, if you are 
shooting with the intent of printing or if you plan on doing a lot of image editing, tagging 
your images with the larger Adobe RGB color space is a better option. If you’re shooting 
raw, your camera setting is not as critical, because you can always select a different color 
space later. But even though you can always re-tag your images later, having them come 
out of the camera properly tagged will save you a step during your postproduction phase.

Color Management in Capture NX
Once you’ve acquired and installed the requisite monitor and printer profi les, you might 
want to make a few preference changes in Capture NX.

1. Open Capture NX’s Preferences and click the Color Management tab.

2. Change the Default RGB color space pop-up menu to the color space that you’d 
like to use for your images. As discussed in the sidebar “A Close Look at Color 
Spaces,” you’ll probably want to set this to sRGB or Adobe RGB, or keep it at its 
default of Nikon Adobe RGB. This is the same as the Adobe RGB color space and is 
provided for those users who don’t have an Adobe RGB profi le already installed on 
their system.

If you want, you can change the Printer Profi le pop-up menu to a specifi c printer profi le, 
but you’ll also have the opportunity to set a printer profi le when you print. I’ll discuss 
printing and the color management issues related to printing in detail in Chapter 8, 
“Output.”



OPENING IMAGES
You can open your images in Capture NX in many ways, and which one is right for 
you is largely a matter of personal preference. (I’m assuming you’ve already transferred 
your images to your computer, a topic covered in detail in Chapter 3, Interface and 
Basic Workfl ow.”)

Capture NX can open TIFF fi les, JPEG fi les, or Nikon NEF fi les. I’ll have much more to 
say about NEF fi les in Chapter 5, Basic Image Editing.”

Opening with the Browser
As you saw in the previous chapter, Capture NX’s Browser palette lets you see thumbnail 
views of all of the images in a folder. In addition, you can add ratings to your images to 
easily sort out the ones that you want to edit. Once you fi nd an image in the Browser that 
you’d like to begin editing, simply double-click on it or drag it into the NX window to 
open it in Capture NX.

The Open Image Command
The Open Image command (File > Open Image) works just like the Open commands 
in any other application. Choose it, and you’ll be presented with your operating system’s 
standard Open dialog box, which lets you navigate to the fi le that you want to open. Select 
the fi le and click the Open button to open it in Capture NX.

Open Recent
Under the File menu you’ll also fi nd an Open Recent command, which lists the last 
nine documents that you’ve opened. You can simply select one of these items to reopen 
the document.

The Welcome Dialog Box
When you launch Capture NX, the program displays a dialog box that lists the last ten 
images that you’ve opened. Click one of these images and Capture NX opens it. The Open 
Recent Browser section of the dialog box shows the last ten folders that you’ve viewed in 
the Browser palette. You can click one of these folders to automatically browse that folder 
(Figure 4.9).

OPENING IMAGES 73
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Figure 4.9 Capture NX’s 
welcome screen provides 
single-click shortcuts to recently 
opened documents and folders. 
You can deactivate this screen 
by checking the Don’t Show 
Again check box and reopen it 
later by choosing Help > Show 
Welcome Screen.

In the New section, you’ll fi nd options for invoking the program’s Open dialog box and 
Open Folder in Browser dialog box. You can also drag an image from your desktop into the 
“Drag an image here to open it” portion of the dialog box to open it immediately.

If you’d rather not be presented with the Welcome dialog box, click the “Don’t show 
again” check box.

Opening from Your OS
Of course, you can also open images in Capture NX using all of the normal mechanisms 
provided by your operating system.

Opening Raw Files

Capture NX can open the raw fi les that are produced by almost any raw-capable Nikon camera. It can-
not open raw fi les produced by non-Nikon cameras. If you’re working with non-Nikon raw fi les, you’ll 
need to perform your initial raw conversion using a different program and save the resulting images 
as TIFF fi les. You can then bring those TIFF images into Capture NX. (See Chapter 3 for more on these 
types of workfl ow concerns.)

Some raw-capable image editors require you to fi rst perform a raw conversion step before passing the 
results on to the rest of your image editing process. In Capture NX, there is no separate raw conversion 
step. Simply open a Nikon raw fi le just as you would a TIFF or JPEG and start editing. All of your image 
editing controls will look the same no matter what type of image you’re editing, although you may fi nd 
some extra functionality in some controls when working with raw fi les. I’ll cover all of these differences 
throughout the next two chapters




